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Notice

1. Descriptions of circuits, software and other related information in this document are provided only to illustrate the
operation of semiconductor products and application examples. You are fully responsible for the incorporation of these
circuits, software, and information in the design of your equipment. Renesas Electronics assumes no responsibility for
any losses incurred by you or third parties arising from the use of these circuits, software, or information.

2. Renesas Electronics has used reasonable care in preparing the information included in this document, but Renesas
Electronics does not warrant that such information is error free. Renesas Electronics assumes no liability whatsoever
for any damages incurred by you resulting from errors in or omissions from the information included herein.

3. Renesas Electronics does not assume any liability for infringement of patents, copyrights, or other intellectual property
rights of third parties by or arising from the use of Renesas Electronics products or technical information described in
this document. No license, express, implied or otherwise, is granted hereby under any patents, copyrights or other
intellectual property rights of Renesas Electronics or others.

4. You should not alter, modify, copy, or otherwise misappropriate any Renesas Electronics product, whether in whole or
in part. Renesas Electronics assumes no responsibility for any losses incurred by you or third parties arising from such
alteration, modification, copy or otherwise misappropriation of Renesas Electronics product.

5. Renesas Electronics products are classified according to the following two quality grades: “Standard” and “High
Quality”. The recommended applications for each Renesas Electronics product depends on the product’s quality grade,
as indicated below.

“Standard”: Computers; office equipment; communications equipment; test and measurement equipment; audio
and visual equipment; home electronic appliances; machine tools; personal electronic equipment; and industrial
robots etc.

“High Quality”: Transportation equipment (automobiles, trains, ships, etc.); traffic control systems; anti-disaster
systems; anticrime systems; and safety equipment etc.

Renesas Electronics products are neither intended nor authorized for use in products or systems that may pose a
direct threat to human life or bodily injury (artificial life support devices or systems, surgical implantations etc.), or may
cause serious property damages (nuclear reactor control systems, military equipment etc.). You must check the quality
grade of each Renesas Electronics product before using it in a particular application. You may not use any Renesas
Electronics product for any application for which it is not intended. Renesas Electronics shall not be in any way liable
for any damages or losses incurred by you or third parties arising from the use of any Renesas Electronics product for
which the product is not intended by Renesas Electronics.

6. You should use the Renesas Electronics products described in this document within the range specified by Renesas
Electronics, especially with respect to the maximum rating, operating supply voltage range, movement power voltage
range, heat radiation characteristics, installation and other product characteristics. Renesas Electronics shall have no
liability for malfunctions or damages arising out of the use of Renesas Electronics products beyond such specified
ranges.

7. Although Renesas Electronics endeavors to improve the quality and reliability of its products, semiconductor products
have specific characteristics such as the occurrence of failure at a certain rate and malfunctions under certain use
conditions. Further, Renesas Electronics products are not subject to radiation resistance design. Please be sure to
implement safety measures to guard them against the possibility of physical injury, and injury or damage caused by fire
in the event of the failure of a Renesas Electronics product, such as safety design for hardware and software including
but not limited to redundancy, fire control and malfunction prevention, appropriate treatment for aging degradation or
any other appropriate measures. Because the evaluation of microcomputer software alone is very difficult, please
evaluate the safety of the final products or systems manufactured by you.

8. Please contact a Renesas Electronics sales office for details as to environmental matters such as the environmental
compatibility of each Renesas Electronics product. Please use Renesas Electronics products in compliance with all
applicable laws and regulations that regulate the inclusion or use of controlled substances, including without limitation,
the EU RoHS Directive. Renesas Electronics assumes no liability for damages or losses occurring as a result of your
noncompliance with applicable laws and regulations.

9. Renesas Electronics products and technology may not be used for or incorporated into any products or systems whose
manufacture, use, or sale is prohibited under any applicable domestic or foreign laws or regulations. You should not
use Renesas Electronics products or technology described in this document for any purpose relating to military
applications or use by the military, including but not limited to the development of weapons of mass destruction. When
exporting the Renesas Electronics products or technology described in this document, you should comply with the
applicable export control laws and regulations and follow the procedures required by such laws and regulations.

10. Itis the responsibility of the buyer or distributor of Renesas Electronics products, who distributes, disposes of, or
otherwise places the product with a third party, to notify such third party in advance of the contents and conditions set
forth in this document, Renesas Electronics assumes no responsibility for any losses incurred by you or third parties as
a result of unauthorized use of Renesas Electronics products.

11. This document may not be reproduced or duplicated in any form, in whole or in part, without prior written consent of
Renesas Electronics.

12. Please contact a Renesas Electronics sales office if you have any questions regarding the information contained in this
document or Renesas Electronics products, or if you have any other inquiries.

(Note 1) “Renesas Electronics” as used in this document means Renesas Electronics Corporation and also includes its
majority owned subsidiaries.

(Note 2) “Renesas Electronics product(s)” means any product developed or manufactured by or for Renesas Electronics.

(2012.4)




Disclaimer

By using this Renesas Starter Kit (RSK+), the user accepts the following terms:

The RSK+ is not guaranteed to be error free, and the entire risk as to the results and performance of the RSK is
assumed by the User. The RSK+ is provided by Renesas on an “as is” basis without warranty of any kind whether
express or implied, including but not limited to the implied warranties of satisfactory quality, fitness for a particular
purpose, title and non-infringement of intellectual property rights with regard to the RSK+. Renesas expressly
disclaims all such warranties. Renesas or its affiliates shall in no event be liable for any loss of profit, loss of data,
loss of contract, loss of business, damage to reputation or goodwill, any economic loss, any reprogramming or recall
costs (whether the foregoing losses are direct or indirect) nor shall Renesas or its affiliates be liable for any other
direct or indirect special, incidental or consequential damages arising out of or in relation to the use of this RSK+,
even if Renesas or its affiliates have been advised of the possibility of such damages.

Precautions

The following precautions should be observed when operating any RSK+ product:

This Renesas Starter Kit is only intended for use in a laboratory environment under ambient temperature and humidity
conditions. A safe separation distance should be used between this and any sensitive equipment. Its use outside the
laboratory, classroom, study area or similar such area invalidates conformity with the protection requirements of the
Electromagnetic Compatibility Directive and could lead to prosecution.

The product generates, uses, and can radiate radio frequency energy and may cause harmful interference to radio
communications. However, there is no guarantee that interference will not occur in a particular installation. If this
equipment causes harmful interference to radio or television reception, which can be determined by turning the
equipment off or on, you are encouraged to try to correct the interference by one or more of the following measures;

e ensure attached cables do not lie across the equipment

e reorient the receiving antenna

e increase the distance between the equipment and the receiver

e connect the equipment into an outlet on a circuit different from that which the receiver is connected
e power down the equipment when not in use

e consult the dealer or an experienced radio/TV technician for help NOTE: It is recommended that wherever
possible shielded interface cables are used.

The product is potentially susceptible to certain EMC phenomena. To mitigate against them it is recommended that the
following measures be undertaken;

e The user is advised that mobile phones should not be used within 20m of the product when in use.
e The user is advised to take ESD precautions when handling the equipment.

The Renesas Starter Kit does not represent an ideal reference design for an end product and does not fulfil the
regulatory standards for an end product.




How to Use This Manual

1. Purpose and Target Readers

This manual is designed to provide the user with an understanding of how to use the CS+ IDE to develop and
debug software for the RSK+ platform. It is intended for users designing sample code on the RSK+ platform,
using the many different incorporated peripheral devices.

The manual comprises of step-by-step instructions to load and debug a project in CS+, but does not intend to
be a complete guide to software development on the RSK+ platform. Further details regarding operating the
RX71M microcontroller may be found in the Hardware Manual and within the provided sample code.

Particular attention should be paid to the precautionary notes when using the manual. These notes occur within the body
of the text, at the end of each section, and in the Usage Notes section.

The revision history summarizes the locations of revisions and additions. It does not list all revisions. Refer to the text of
the manual for details.

The following documents apply to the RX71M Group. Make sure to refer to the latest versions of these
documents. The newest versions of the documents listed may be obtained from the Renesas Electronics Web
site.

Document Type Description Document Title Document No.
User’s Manual Describes the technical details of the RSK+ RSK+RX71M User’s R20UT3217EG
hardware. Manual
Tutorial Manual Provides a guide to setting up RSK+ environment, RSK+RX71MTutorial R20UT3218EG
running sample code and debugging programs. Manual
Code Generator Provides a guide to code generation and importing RSK+RX71M Code R20UT3220EG
Tutorial Manual into the CS+ IDE. Generator  Tutorial
Manual
Quick Start Guide Provides simple instructions to setup the RSK+ and RSK+RX71M Quick R20UT3219EG
run the first sample, on a single A4 sheet. Start Guide
Schematics Full detail circuit schematics of the RSK+. RSK+RX71M R20UT3216EG
Schematics
Hardware Manual Provides technical details of the RX71M RX71M Group RO1UHO0493EJ
microcontroller. Hardware Manual




2. List of Abbreviations and Acronyms

Abbreviation Full Form
ADC Analog-to-Digital Converter
API Application Programming Interface
bps Bits per second
CMT Compare Match Timer
COM COMmunications port referring to PC serial port
CPU Central Processing Unit
DVvD Digital Versatile Disc
El Renesas On-chip Debugging Emulator
GUI Graphical User Interface
IDE Integrated Development Environment
IRQ Interrupt Request
LCD Liquid Crystal Display
LED Light Emitting Diode
LSB Least Significant Bit
LVD Low Voltage Detect
MCU Micro-controller Unit
MSB Most Significant Bit
PC Personal Computer
Pmod™ Thi§ is a Digilent Pmod™ C;Qmpatible connector. Pmod™ is registered to Digilent Inc.
Digilent-Pmod_Interface_Specification
PLL Phase-locked Loop
RAM Random Access Memory
ROM Read Only Memory
RSK+ Renesas Starter Kit+
RTC Realtime Clock
SAU Serial Array Unit
SCI Serial Communications Interface
SPI Serial Peripheral Interface
TAU Timer Array Unit
TFT Thin Film Transistor
TPU Timer Pulse Unit
UART Universal Asynchronous Receiver/Transmitter
USB Universal Serial Bus
WDT Watchdog timer

All trademarks and registered trademarks are the property of their respective owners.


http://www.digilentinc.com/index.cfm
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LENESANS

RSK+RX71M

RENESAS STARTER KIT+

R20UT3218EG0100
Rev. 1.00
Jan 23, 2015

1. Overview

1.1  Purpose

This RSK+ is an evaluation tool for Renesas microcontrollers. This manual describes how to get the RSK+
tutorial started, and basic debugging operations.

1.2 Features

This RSK+ provides an evaluation of the following features:

The RSK+ board contains all the circuitry required for microcontroller operation.

Renesas microcontroller programming

User code debugging

User circuitry such as switches, LEDs and a potentiometer
Sample application

Sample peripheral device initialization code

R20UT3218EG0100 Rev. 1.00
Jan 23, 2015 RENESAS
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RSK+RX71M 2. Introduction

2. Introduction

This manual is designed to answer, in tutorial form, the most common questions asked about using a Renesas
Starter Kit+ (RSK+). The tutorials help explain the following:

e How do | compile, link, download and run a simple program on the RSK+?
e How do | build an embedded application?
e How do | use Renesas’ tools?

The project generator will create a tutorial project with three selectable build configurations:
e ‘DefaultBuild’ is a project with debug support and optimisation level set to two.
e ‘Debug’is a project built with the debugger support included. Optimisation level is set to zero.

e ‘Release’is a project with optimised compile options (level two), producing code suitable for release in a
product.

Files referred to in this manual are installed using the project generator as you work through the tutorials. The
tutorial examples in this manual assume that installation procedures described in the RSK+ Quick Start Guide
have been completed. Please refer to the Quick Start Guide for details of preparing the configuration.

Some of the illustrative screenshots in this document will show text in the form RXxxx. These are general
screenshots and are applicable across the whole RX family. In this case, simply substitute for RXxxx RX71M

These tutorials are designed to show you how to use the RSK+ and are not intended as a comprehensive introduction to
the CS+ debugger, compiler toolchains or the E1 emulator. Please refer to the relevant user manuals for more in-depth
information.

2.1 Code Generator Plug in

The Code Generator plug in for the RX71M has been used to generate the sample code discussed in this
document. Code Generator for CS+ is a plug in tool for generating template ‘C’ source code and project
settings for the RX71M. When using Code Generator, the engineer is able to configure various MCU features
and operating parameters using intuitive GUI controls, thereby bypassing the need in most cases to refer to
sections of the Hardware Manual.

Code Generator is not enabled by default during CS+ installation and is not required for this tutorial manual.
For more information please refer to the ‘Enabling Code Generator’ section of the Code Generator Tutorial
manual.

Once the engineer has configured the project, the ‘Generate Code’ function is used to generate three code
modules for each specific MCU feature selected. These code modules are name ‘r_cg_xxx.h’, ‘r_cg_xxx.c’,
and ‘r_cg_xxx_user.c’, where ‘xxx’ is a three letter acronym for the relevant MCU feature, for example ‘adc’.
Within these code modules, the engineer is then free to add custom code to meet their specific requirement.
Custom code should be added, whenever possible, in between the following comment delimiters:

/* Start user code for adding. Do not edit comment generated here */
/* End user code. Do not edit comment generated here */

Code Generator will locate these comment delimiters, and preserve any custom code inside the delimiters on
subsequent code generation operations. This is useful if, after adding custom code, the engineer needs to re-
visit Code Generator to change any MCU operating parameters.

R20UT3218EG0100 Rev. 1.00 ———r
Jan 23, 2015 RENESAS




RSK+RX71M 3. Tutorial Project Workspace

3. Tutorial Project Workspace

3.1 Introduction

CS+ is an integrated development tool that allows the user to write, compile, program and debug a software
project on the RX, 78K, RL and V850 family of Renesas microcontrollers. CS+ will have been installed during
the installation of the software support for the Renesas Starter Kit product. This manual will describe the
stages required to create and debug the supplied tutorial code.

3.2 Starting CS+

To use the program, start CS+:
Windows™ 7 & Vista: Start Menu (Start Menu > All Programs > Renesas Electronics CS+ > CS+ for CC (RX, RH850)

Windows™ 8: From Apps View @ click ‘CS+ for CC (RX, RH850)’ icon

The first time CS+ is started, the One Point Advice dialog box will be shown:

One Point Advice @

Do you know?

Can e2 studio project be openad?
e2 studio project can be loaded in this product.

Select [Project] -» [Open Project.. ], and select a project file {rcpc) of
the &2 studio.

* Displayed contents, random.

027/050 | <Back |[ Ne> |

7] Do not show this dialog box at startup [ QK ] ’ Help ]

The One Point Advice dialog box provides some useful tips when using CS+. Press ‘OK’ to skip the advice
and close the One Point Advice dialog. The user will then be presented with the Start panel.

Under the ‘Open Sample RSK Project’, open a new Tutorial project by selecting the RSK+RX71M_Tutorial
project template and click on ‘Go’ as shown below. This will save a copy of the RSK+RX71M_Tutorial project.

Open Sample RSK Project
Select an RSK project template from those installed:

RSK+R¥7 1M Tutorial

Tutorial Project
Tutorial code demonstrating the operation of the debugger.

R20UT3218EG0100 Rev. 1.00 RENESAS Page 9 of 26
Jan 23, 2015



RSK+RX71M

3. Tutorial Project Workspace

e CS+ will present a ‘Create Project’ dialog
box.

e Select all sub-projects by clicking on
each checkbox and observe the
information  displayed under the
‘Subproject information’ heading as you
select each project.

e Specify a name and location for the new
project and click on ‘Create’

e A dialog box will appear if the location
specified does not exist; asking to create
the folder specified. Click ‘OK’.

Subprojects to Add :

Create Project

Subproject information :

==

Low_Power_Mode
RTC
System_Input_Capture
Timer_PWM

Name :  RSK+RX71M_Tutorial

Location :  C'workspace
Make the project folder

e CS+ will create and open the project
showing the Project Tree as seen in the
screenshot opposite.

e RSK+RX71M_Tutorial (Project) is the
master project and includes the tools to
modify, build and debug the code.

e The File folder seen in the screenshot
belongs to the master project,
RSK+RX71M_Tutorial.

e This folder contains and lists all project
source and header files including text
files arranged in separate folder
structures.

e Folders containing the subprojects,
indicated by “(Subproject)”, are listed
below the File folder.

e Each subproject folder, when expanded,
reveals an identical tools and folder
structure to that of the master project,
RSK+RX71M_Tutorial.

e By default the RSK+RX71M_Tutorial
project is set as the active project,
indicated by the line under the project
name.

Note: ‘Code Generator (Design Tool)’' node is
shown in the ‘Project Tree’ and indicates an
optional  plug-in  has been enabled
previously.

A
Z

E‘.

Project Tree

© 8| [E

B { RSK+RX71M Tutorial (Project)

..... I RSF571MLCFC (Microcontroller)
- % Code Generator (Design Toal)

..... A CC-RX (Build Tool)

----- == RX ELJTAG) (Debug Tool)
-3 File

=- f; Application (Subproject)

- °=~| Code Generator (Design Tool)
..... A, CC-R¥ (Build Tool)
----- ¢, RX EL(JTAG) (Debug Tool)
-3 File
= f; Asyne_Serial (Subproject)
- E, RSF5T1MLCxFC (Microcontrolle
[+ '3:\] Code Generator (Design Tool)
..... 4 CC-RX (Build Toal)
----- ¢ RX EL(TAG) (Debug Tool)
-3 File
= f; Low_Power_Mode (Subproject)
- 5 RSFAT1MLCxFC (Microcontrolle
[ °:~I Code Generator (Design Tool)
..... A, CC-RX (Build Tool)
----- 2p, RX EL(TAG) (Debug Tool)
-3 File
=-| % RTC (Subproject)
i RSF571MLCxFC (Microcontrolle
[ °:~| Code Generator (Design Tool)
..... 4, CC-RX (Build Tool)
..... e R EL(JTAG) (Debug Tool)
-3 File
= ]’; Systern_Input_Capture (Subproject)
""" RSF5T1MLCxFC (Microcontrolle
[+ thl Code Generator (Design Tool)
..... 4 CC-RX (Build Tool)
----- ¢ RX E1(TAG) (Debug Tool)
- File
-/ & Timer_PWM (Subpraject)
E, RSF5TIMLCxFC (Microcontrolle
:~I Code Generator (Design Tool)

m

R20UT3218EG0100 Rev. 1.00
Jan 23, 2015
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RSK+RX71M 3. Tutorial Project Workspace

e To change the active project, right- Project Tree X
click on the project/subproject name = =
and select “Set x as Active Project” . _® 2 &
(x represents the project name). - % RSK+RX71M Tutorial (Project]
3:&, RSFSTIMLCFC (Microcentroller) b mtsp

-4 Code Generator (Design Teol) HRX71M_Tutorial Application®Apr
i 7 Pin View

D_;;J Peripheral Functions

,_;! Code Preview

- Ay, CC-RX (Build Tool)

i, RX EL(JTAG) (Debug Tool)

i1 File

|:—:|| ﬁ Application
. RSFSTIMLCKFC (Mi

J Code Generator (De

LAy CC-RX (Build Tool)

2l RX EL{JTAG) (Debud

a@-[3l File

- ﬁ Async_Serial (Subproje

]| ﬁ Low_Power_Mode (Sub

- RTC (Subproject) Add v

| ﬁ Systemn_Input_Capture ‘r_ﬁ Set Application as Active Project

- % Timer_PWM (Subproje

Build RSK+RX71M_Tutorial
Rebuild RSK+RX7 LM_Tutorial
Clean REK+FRX71M_Tutorial

COpen Folder with Explorer

T Al ]

Windows Explorer Menu

oy TN s TN o OO O

E_l Remowve from Project Shift+Del
Paste Cerl+V

Rename F2

Property

e The File folder contains four -
subfolders. This structure is common NIE|EESSES B
to all projects. ¢ @ 8 | [E

e Some of the source files were '
generated by Code Generator, which
are grouped under the ‘Code
Generator’ folder which itself is listed :
under the File folder in the Project | || = | & regade| 2 Compile
Tree. These files are prefixed with | || i '-ﬂ Fcg_cqod o
‘r_cg’ to indicate that they were | || i i €| rcg_cge J
generated by a code generator. All | || ¢ @ i & r_cqintp. 2 Openwith Internal Editor...
other user-generated source files are =
contained in the ‘C Source Files' | || .+ & = r_cg.intp,
folder. 1 i

e To open a file for viewing, right-click
on the file and select ‘Open’.
Alternatively, double-click on the file.

[__-_|I: Code Generator -
..... & lcd_panel.c

Open

Open with Selected Applicat

Dpen Folder with Explarer

R20UT3218EG0100 Rev. 1.00 RENESAS Page 11 of 26
Jan 23, 2015



RSK+RX71M 3. Tutorial Project Workspace

3.3 Configuring the Debug Tool (E1)

Note: The Tutorial sample project’s settings are pre-configured. This section is intended to familiarise the user
with the debug tool settings for when they create their own project.

e The Project Tree will be displayed on the
left-hand pane of CS+.

e This can also be invoked from the menu
bar [View > Project Tree].

RSK+RX71M_Tutoerial - CS+ for CC - [Project Tree]
File Edit |View | Project Build Debug Tocl Window
E@ Star Project Tree

e The opposite screen-shot indicates that | EEEESEE il | 7% property | r.ce_maine
H A
the selected Debug Tool is E1. 4 ® 2 & 5 RXEIUTAG) Property
-/} RSK+RX71M Tutorial (Project)* + Internal ROMRAM

ﬁ R5F571MLCxFC (Microcontroller)
i\ °___§ Code Generator (Design Tool)
LAy CC-RX (Build Tool) Size

P RX E1(JTAG) (Debug Too 4_Clock

Size of internal ROM[KBytes]
internal RAMIK
D

ataFlash memory[KBytes]

-3 File Using Debug Tool  » RX E1(Serial)
Property RX ELUTAG) pt
RXE20(Serial) |
4 Comnec| | py £20(TAG)
Power ta
Commun RX Simulator
JTAG clock[MHz]
e Right click on RX E1(JTAG) (DebugTool). S3 BX E1(JTAG) Propetty
Click on Property. 4 Internal ROWRAM
View the Connect Settings. Size of internal ROM[KBytes] 4096
. . . Size of internal RAM[KEytes] 552
e Verify that the settings match the opposite Size of DataFlash memory[KBytes] g4
screen-shot. 4 Clock
Main clock source EXTAL
Main clock frequency[MHz] 240000
Operating frequency[MHz] 240.0000

Allow changing of the clock source on wri No

4 Connection with Emulator

4 Connection with Target Board
Power target from the emulator. (MAX 2001 No
Communications method JTAG

JTAG clock[MHz] 16.5
The project is configured to halt code

- - : . ’ Property
execution on the first instruction of the main

function after programming the microcontroller. | |£* RXEIUTAG) Property

To specify another function as an entry point: 4 Download
P Download files [1]
. . S . CPU Reset after download Yes
e View the ‘Download files’ Settings of the Erase flash ROM before download Vo

RX E1’s property.

e Change the ‘specified symbol' to another
available function.

Erase data flash ROM before download Mo
Automatic change method of event zetting position Sugpend event
4 DebugInformabon

Execute to the specified symbal after CPU Reset Yes

e Ensure to prefix the function name with an Apsaiiscaymndl AR
underscore (“ ,,) Specify the debugged overlay section Mo
-7 The upper limit size of the memory usage [MEBytes] 500

Note: Do not specify an interrupt handler as
the entry point.

R20UT3218EG0100 Rev. 1.00
Jan 23, 2015
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RSK+RX71M 3. Tutorial Project Workspace

3.4 Build Configuration

The build configurations are selected from the build tool's Property panel. The options available are
‘DefaultBuild’, ‘Debug’ and ‘Release’. ‘DefaultBuild’ and ‘Debug’ are configured for use with the debugger.
‘Release’ is configured for the final ROM programmable code.

A common difference between the two builds is the optimisation setting and the addition of debug information.
With optimisation turned on, the debugger may seem to execute code in an unexpected order. To assist in
debugging it is often helpful to turn optimisation off on the code being debugged.

e Right-click on CC-RX (Build Tool) from | EEEallEs L ox
the Project Tree. A o
‘J , 5 “_D - E) A, CC-RX Property
* Select Property. - RSK-RXT1M Tutorial Projecty R
------ ﬁ R5F571MLCxFC (Microcontroller)
ﬂ _,jCodeGeneratnr(DesngnTool) 4 CPU

A CC U Buld Top S s

S5 RX E1(JTAG) (De Build Project F7
i j File Rebuild Project Shift+F7

L o
E{l! T Application (Suk B Clean Project
"3

E-_]\ ﬁ Async_Serial (Su
Set to Default Build Cption for Project

Import Build Options...

| Set Link Order...

& Property |

e The Common Options sheet will open by Fraperty

default. A, CCRX Property
e Verify that the Build Mode is set to 4 BuildMode

' ’
Debug'. ) | mode Debug
Instruction set architecture R¥v2 architecturef-isa=rav2]

- . - - ; T
i C'“Ck on the Complle Opthl’lS sheet to \Common Dptionsl}, Compile Opti... Jﬂ\Assemblerﬁo...({ Link Options /{
view compller options.

e Ensure the ‘Outputs debug information’ | “ CCRXPuopety

. ‘ ~ ’ > Source
entry is set to ‘Yes(-debug)'. 4 Object
° Ensure the ‘Optimization' entry iS Set tO Output file type _ ) Object module file(-output=obij]
. () Yes(-debug]
O(-Optlm IZe—O) . Section name of program area P
Section name of constant area L
Section name of initialized data area D
B
L

Section name of unintialized data area

Section name of literal area

Section name of switch statement branch table area
Allocates uninitislized variables to 4-byte boundary align Mo
Allocates initislized variables to 4-byte boundary alignme Mo
Allocates const qualified variables to 4-bpte boundary ali No
Allocates switch statement branch tables to 4-byte boun Mo

£

Adjustment for instruction in branch Mane(-noinstalign)
Generates divisions and residues with DIV, DIVU, and t Yes
Character code of an output assembly-language file SJIS code(-outcode=sjis)
> List
4 Dptimization
Optimization level D[-optimize=0)

Dutputs additional information for inter-module optimizati Mo
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RSK+RX71M 4. Building the Tutorial Program

4. Building the Tutorial Program

The tutorial project build settings have been pre-configured in the toolchain options. To view the toolchain
options double-click on CC-RX(Build Tool) from the Project Tree and select the available tabs. It is important
when changing settings to be aware of the current configuration before modifying the settings.

e Review the options on each of the tabs to
be aware of the options available. For the
purposes of the tutorial, leave all options
at default. - ||

e When complete, the Property panel can
be closed by clicking [x] on the right-hand
corner of the Property window.

4.1 Building the Code

There is a choice of three shortcuts available for building the project:

e Selecting the ‘Build Project’ toolbar button will build all projects listed in the project tree.

e Pressing [F7]. This is equivalent to pressing the ‘Build Project’ toolbar button.

2]

e Selecting the ‘Rebuild Project’ toolbar button will rebuild all project files.

e Selecting the ‘Build & Download’ toolbar button will only build the active project and
download the code to the target device after a successful build.

e Pressing [F6]. This is equivalent to pressing the ‘Build & Download’ toolbar button.

E <@

Build the project now by pressing [F7] or pressing one of the build icons as shown above. During the build
each stage will be reported in the Output Window. The build will complete with an indication of any errors and
warnings encountered during the build.
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RSK+RX71M 4. Building the Tutorial Program

4.2 Connecting the Debugger

For this tutorial it is necessary to provide an external power supply to the board. Use the +5V center-positive
PSU supplied with this RSK+ to power the board.

The Quick Start Guide provided with the Renesas Starter Kit board gives detailed instructions on how to
connect the E1 to the host computer. The following assumes that the steps in the Quick Start Guide have
been followed and the E1 drivers have been installed.

e Fit the PMOD LCD display to the board. Ensure all the pins of the connector are correctly inserted in the
socket.

e Connect the E1 Debugger to a free USB port on your computer.

e Connect the E1 Debugger to the target hardware ensuring that it is plugged into the connector marked
‘ET.

e Connect the +5V center-positive PSU to the PWR connector on the RSK+.

4.3 Saving Project Settings

If you have changed any project settings this is a good m B T oo B o
time to save the project.

Mew L
e Select ‘File’ | ‘Save Project'. [ Open.. Ctrl+0

Open with Encoding... L

Add »

_.;f_; Close Project

Close File

[y SaveProject  Ctrl+ShifteS

If you make any changes to files in CS+ and want to
preserve these change, you can save them by: File | Edit View Project Build Debur

ey 3

|k Open.. Ctrl+0

e Select ‘File’ | ‘Save All'.

Openwith Encoding...
Add ’

5 Close Project
Close File

ER Save Project Ctrl+Shift+3

';%—c‘; Sawe Project &,

| Sawe Ohject Ctrl+5

sl Sawe Object As..

¢ Object Save Settings..,
EIEN Crl+Shiftess |

You can also save files by clicking the ‘Save’ or ‘Save All

buttons from the CS+ toolbar. g

In addition files can be saved using the keyboard
shortcut [Ctrl + S]:
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5. Downloading and Running the Tutorial

5.1 Downloading the Program Code

Now that the code has been built in CS+ it needs to be downloaded to the RSK+.

e Click on the program download button.
Alternatively, select Debug from the
Menu bar and click on Download.

e On completion of program download,
the debugger and code are ready to be
executed. The program  counter
indicator will point to first line of code o
inside the ‘main’ function; this is the void main(void)

program’s entry point. T T

R_SWITCH Init():

R_SWITCH_SetPressCallback(cb_switch_press):

£ th

12 call back function when SW1 or SWZ is pressed *

* Initialise the debug L

R LCD Init():

R_LCD Display(0,
R_LCD Display(l,
R_LCD Display(z,

Before proceeding, it is necessary to connect to the RSK+ G1CUSBO port to a PC using a USB Type A to mini
B cable. The first time this port is connected to the PC an 'Installing Device Driver Software' pop-up will
appear and the device driver will be automatically installed. Open Device Manager, the virtual COM port will
appear under 'Port (COM & LPT)' as 'RSK USB Serial Port (COMX)', where x is a number. Open a terminal,
emulation program, such as HyperTerminal, with the settings 19200, 8, N, 1 on the virtual COM port.

5.2 Running the Tutorial

Once the program has been downloaded onto the RSK+ device, the program can be executed.

Click the ‘Go’ button or press F5 to begin the program from the current program counter @
position. It is recommended that you run through the program once first, and then continue to
the review section. Operating instructions for the program can be found in the file
‘Description.txt’, under the ‘Text Files’ folder in the CS+ Project Tree.
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RSK+RX71M 6. Reviewing the Tutorial Program

6. Reviewing the Tutorial Program

This section will look at each section of the tutorial code and basic debugging functionality in CS+.

6.1 Program Initialization

Before the main program can run, the microcontroller must be configured. Due to the debugger configuration
used for the Tutorial project and the rest of the sample projects, the user will not be able to step through the
hardware initialization code. Please refer to Section 3.3 to change the entry point after programming the
microcontroller. Specify ‘_R_Systeminit’ as the function name if viewing of hardware initialization is desired.
The initialization code is executed every time the device is reset via the reset switch or from a power reboot.
The user is advised not to use the ‘step’ feature of the debugger to exit the ‘R_Systeminit’ function.

Ensuring the Tutorial program has been downloaded onto the RX71M; press the ‘CPU Reset’ button

on the Debug Toolbar. s
e From the Menu bar select o ORI
View > Disassemble > FFc007cq D Teaf PUSH.L RE
) i ffe007ch G040 S1IB F4H RO
Disassemblel.  Alternatively, Ffe007cd Fboz04040000 Mov.L #00000404H,RE
i H 91: R_M&TH _UserInit();
use the Display Disassemble Ffe00743 30bd00 BSR.Y R_MAIN Userlnit
button to open and view the c007d5 R‘SWITEEEIHEDU; BSR.4 R_SHITCH Init
I H ] c El . _h_ _lni
source and disassembly’. 98: R_SWITCH SetPressCal lhack(ch_switch_press);
. ffc00Tda fhT29108c0ff Moy .C H-D03FFT6FH,RI
e To make the Display ]mfchD?eD © Lo ?5ba1(§nu BSR. & _R_SYITCH SetPressCallback
H : : LCh _Init();
Disassemble button available ffe007ed 15490400 BSR. A R_LED_Init
on the toolbar, r|ght-c||ck on 104: R_LCD Display(0, (uint8_t ®)7 REK+RATIN 7);
N\ ffc0D7es fh221c0TcOff WMoY L H-D03FFBE4H,R2
the toolbar and select ‘View Ffc07ee FEOT WOy . L HOH,R1
, fFfcO07fo 05e00d00 BSR. 4 R_LCD Display
Panels’. 105: R_LCD Displav(l, (uintB_t )7 Tutorial 7)1
Hcggw EE%%QBD?CDH mgH g;HDEI;FBDBH,RE
AN H [ a . E
<— Disassemble FFoO0TFc 05440400 BSR. 4 _R_LCD Djsplay
button 106: R_LCD Display(2, fuintB_t *)7 Press Any Switch 7);
ffc00800 fb223307c0ff WMoY L H-D03FFSCDH,R2
ffcOD306 BBZ1 Moy . L HZH LR
RBEE 05c80400 BSR. 4 _R_LCD Display
Revert back to the source by clicking
on the file containing the function
pointed to by the program counter
indicator. Alternatively, right click in
the Disassemblel window and click
"Jump to Source"
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RSK+RX71M 6. Reviewing the Tutorial Program

6.2 Main Functions

This section will look at the program code called from with the ‘main()’ function, and how it works.

. . SRR R R RO R R R R R R R R R Rk o ke ] BT TEGISTEr ACTIOn EVent.
b ‘nght CI_ICk . the *-Function-Name:-main ¥| cut Ctrl+X
R_SCI7_Serial_Receive( *-Description - :-This-function-inplements-main-functi )
)’ function call and select *-Argunents: -« - :-None Q) Copy S s
: , *-Return-Yalue-:-None 2 Dacte Ctrl+V
Go to Here’ to execute FRERERREERERERE KKK KR RE R KR KRR KRR R R k] | ST
the program up to this \%oi d-main(void) &y Find Curl+F
line. _ The ‘R_LCD_Init() e R_NAIN UserInit O3 #, GoTo.. Ctrl~G
function call enables and -+ /x-Start-user-code.-Do-not-edit-comment - generated| ~% Forward to Next Cursor Position
;gﬂzlgures the Lai]l?j -+« f%-Initialize-the-switch-module-%/ [ i I Rt
, ) | o+ -R_SWITCH_Init (); N Gatoh
‘R_LCD_Display()’  will 3 ek
write “RSK+RX71M” onto cveo /% Setethescal | -hack-function-whens S¥1-or-§W2-ig-| @ SetPCtoHere
. . N~ <o+ -R_SWITCH SetPressCallback (ch_switch press); ~ to Functi F12
the top line, “Tutorial” on § ‘umptofunction
the second line and s feeInitializesthe -debug-LCD-%/ &' Taglump Shift+F12
“Press Any Switch” on the :R_LCD_[MH)’ %, Jump to Disassemble
third. -Q*Lgaﬁs!w?-ﬂag-a?p! iEgtio:;qar_n:_yur_w‘Eh@‘g{ﬁbugsL(iD Bookmarks i
<o -R_LCD Display (0, -luints_t- w-J;
<+ R_LCD Display (1, (uintB_t-*)" Tutorial-7]; Advanced »
-:R_LDD_Dmplay(?,-(umtE_t-*l *Press-Any:Switch-") Break Settings R
o+ f4-8tart-the-#/D-converter-%/ Trace Settings »
<-R_S12AD0_Start(); TSRS it
e f%8et-up-SCIT- receive-buffer-and-cal lback: functi B Save Source Mixed Data As
-+R_8CI7 Serial Receive((uint8_t-#)4g_rx_char,-1); —
v+« f%-Enable-SCI7- operat ions %/
--R_SCI7 Start();
e Set a breakpoint on the e ¥ Betoup-S0IT- recaive- buffer-and-cal Ihack- function-*/
‘R_SCI7_Start() function | [v | ==-R_SCI7_Serial Receive ({uint8_t-*)&e_ru_char,-1);
call by clicking on the On-
. . e foEnable-SCIT- aperat jons-*/
Chip Breakpoint column [% ----R_SCIT Start();
to the left of the number
column.
e Click the ‘Step In’ button —
to  step into  the =
‘R_SCI7_Serial_Receive(
)’ function. Alternatively,
press [F11].
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6. Reviewing the Tutorial Program

e The program counter
should now move into the
‘R_SCI7_Serial_Receive(
)" function definition. This
function is an API function
provided by the Code

Generator. It sets up the
SCI7 interrupt handler
code to receive a

specified number of bytes
into a receive buffer.
Once the specified
number of bytes has
been received, the
interrupt handler code
calls a callback function
as shown later on in this
section.

e For full details on how to
configure a project using
Code Generator refer to
the Code  Generator
Tutorial Manual.

e Press the ®button to

MD_STATUS-R_SCI7_Serial _Receiveluint8_t-*-const - rx_buf. uint16_t rx_num)

- MD_STATUS -status-=-HD_OK;
i (U rx_num)
{

-------- status-=-MD_ARGERROR;

-------- g scii_rx_count-=-0U;
-------- g_scil_ri_length-=-rx_num;
-------- gp_scil_rx_address- = rx_huf;
-------- SCIT.SCR.BIT.RIE-=- 113
-------- SCIT.SCR.BIT.RE-=-1U:

--return: (status);

resume program
execution.
e The program counter coee e SeteupeSCIT-receive - buffer-and-cal Thack: function-*/
should come to a halt at | | --R_SCI7_Serial Receive ((uint8_t-*)&g_rx_char,-1);
the ‘R_SCI7_Start’ ,
function. < feEnable-5C17-operat fons -/

e Step over the function by
clicking the ‘Step Over’
button. Alternatively,
press F10.

[_

The ‘R_SCI7_Start()’ function
enables the SCI interrupts.
The program then proceeds
to the main while() loop. The
code inside the loop waits for
user input from either SCI
reception or RSK+ switches,
and then performs an A/D
conversion.

&

~-R_SCI7_Start();

wh| le- (10)
-
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6. Reviewing the Tutorial Program

Locate the function call to
‘Icd_display_adc()’ inside the
while loop.

Set a breakpoint on the
‘lcd_display_adc()’ function call
by on the On-Chip Breakpoint
column to the left of the number
column.

In the Project Tree pane, locate
the file ‘r_cg_sci_user.c’ and
double-click to open the source
file. Scroll down to the function
‘r_sci7_callback_receiveend()'.

--while- (100
-1
seeeeeyint 1B t-ado_result;

cereee Wit - for-user-requested- /D conversion-f lag-to-he-get -

H ceeeoee s i f - (TRUE-==- g_adc_trizeer)
seeeeesfeeCall-the-function-to-perform-an- &/0- conversion-*/

i ceeeseseeemade _result-=-get _ade();

<oeeeeee s Se-Display-thes result-on-the LOD-x/
|5 oo led diselay _ade (ade_result);

Set a breakpoint on the line of
code inside the
‘r_sci7_callback_receiveend’
function as shown opposite.

Continue to execute the

program by pressing the @
button.

} static-void-r_sci7_cal lback_receiveend(void)

<+ f#8tart-user-code.-Do-not-edit-comment - zenerated-here-%/
< Check-the-contents-of -2 rx _char-%/
i ceenife (e == g e chard- | |- (°CT == g rx_char))
[% | B g adc_trizeer-=-TRUE;
e}
< S Beteup 8017 receive-huffer-and-cal lhack- function-azain-*/

} <o R S5CI7 Serial Receive({uintB t-=)&eg rx _char,-1);

<+ f#End-user-code.-Do-not -edit -conment - zenerated-here -3/

][.

In the terminal; emulation [ static-void-r_sci7_cal lback_receiveend{void)
Vl\!]ln?(owk’)prejs the ‘c’ button on <o f%-Start-user-code.-Do-not -edit -comment - generated-here- =/
the keyboard. --/'*-Chgck-the-cnntents-uf'g_lrx._char'*/
The program W|” halt at the l I{]c (( = '::'g_r}{_char)' | |( C '::'g_r}{_char”
breakpoint in the | jse [ ; -
. . IG5 | rereere do_t -=-TRUE;
‘r_sci7_callback_receiveend’ e |... -] satErieset
function as shown opposite.
Remove the breakpoint by cee S Betoup-3CIT- receive-buffer-and-cal Iback: function-azain-*/
clicking on the breakpoint l <oo R SCI7 Serial Receive(({uintB t-#)&e ru_char,-17;
column. <o+ f%-End-user-code.-Do-not-edit -conment - generat ed-here-%/
Continue to execute the i
program by pressing the @ IR F#-Display-the-result-on-the-LC
button. R | e reeeaeees lcd _display_adclade_result);
The program will halt at the
breakpoint in the main while | | r=rrereeeees J#-Increment -the-adc_count - and-
loop. TR if-(16-==- (++adc_count )
Remove the breakooint by | | =ttt I

the breakpoint by
clicking on the breakpoint
column. Continue to execute
the program by pressing the

button.

R R Eldc_cl:lunt':'[l;

| led display count (adec _count )

The program proceeds to display the result of the A/D conversion on the LCD and in the terminal window. In
addition, the running count of A/D conversions performed is displayed in binary form using LEDs 0-3 on the
RSK+. Adjust the potentiometer and press any switch on the RSK+ and an additional A/D conversion will be
performed.
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RSK+RX71M 6. Reviewing the Tutorial Program

e Press the ‘Stop’ button to halt —
program execution. ’.....|

e This is the extent of the tutorial code.

For further details regarding hardware configuration, please refer to the RX Family Software Manual and the RX71M
Group Hardware Manual.

The E1 emulator features advanced logic-based event point trigger system, and full instruction on its use is outside the
scope of this tutorial. For further details, please refer to the E1/E20 Emulator User’s Manual
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7. Additional Information

Technical Support

For details on how to use CS+, refer to the help

file by opening CS+, then selecting Help > Help —
Contents from the menu bar. 20l Window | Help |

) | S ‘@ Help

] @+ Cpen Help for Start Panel F1
ﬂ‘; Cne Point Advice...

B Tutorial

art |

Learn -
@] Browse Renesas Electronics Microcontrollers Web

(i Detail Version Information...

{3} About...

Parts of the sample code provided with the RSK+RX71M can be reproduced using the Code Generator plug in
ggm&rce files and functions generated by Code Generator are prefixed with ‘r_"and ‘R_’, respectively.

For information about the RX71M Group microcontrollers refer to the RX71M Group Hardware Manual.

For information about the RX assembly language, refer to the RX Family Software Manual.

Technical Contact Details

Please refer to the contact details listed in section 8 of the “Quick Start Guide”

General information on Renesas microcontrollers can be found on the Renesas website at:
http://www.renesas.com/

Trademarks
All brand or product names used in this manual are trademarks or registered trademarks of their respective
companies or organisations.

Copyright

This document may be, wholly or partially, subject to change without notice. All rights reserved. Duplication of
this document, either in whole or part is prohibited without the written permission of Renesas Electronics
Europe Limited.

© 2015 Renesas Electronics Europe Limited. All rights reserved.
© 2015 Renesas Electronics Corporation. All rights reserved.
© 2015 Renesas System Design Co., Ltd. All rights reserved.
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